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1 Allgemeine Informationen 

Adresse 
INNEO Solutions GmbH 
Technischer Support 
Rindelbacher Straße 42 
73479 Ellwangen 

Rufnummer, Fax und E-Mail Adresse 
Telefon:  00800 4200 4300 (gebührenfrei bei Anrufen aus D, CH, A, GB) oder 
 +49 7961 890-800 (kostenpflichtig) 
E-Mail:  support@inneo.com 

 

 

Erreichbarkeit PTC Support / PM Support: 
Innerhalb unserer Geschäftszeiten: 

Montag bis Freitag von 08:00 Uhr bis 18:00 Uhr  

Außerhalb unserer Geschäftszeiten (nur in englischer Sprache): 
Montag 00:00 Uhr bis 08:00 Uhr 
Montag bis Donnerstag von 18:00 Uhr bis 08:00 Uhr 
Freitag von 18:00 Uhr bis 24:00 Uhr 
 

Erreichbarkeit NetApp Support (24/7): 
Innerhalb unserer Geschäftszeiten  
Montag bis Freitag von 08:00 Uhr bis 18:00 Uhr: 

Außerhalb der Geschäftszeiten: 
Telefonischer Bereitschaftsdienst (nur NetApp SSC Support) 
 

Erreichbarkeit INNEO Cloud Support und Managed Services: 
Innerhalb unserer Geschäftszeiten  
Montag bis Freitag von 08:00 Uhr bis 18:00 Uhr: 

Telefon: +49 (0) 7961 890 600 
E-Mail: itsupport@inneo.com 

mailto:support@inneo.com
mailto:itsupport@inneo.com
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2 Bevor Sie den Technischen Support kontaktieren 

2.1 Checkliste PTC Support 

1. Dokumentation prüfen, um sicherzustellen, dass die Vorgehensweise die Richtige für das 
gewünschte Ergebnis ist.  

2. Ist das Problem reproduzierbar?  

3. Tritt das Problem auch bei neuen, vereinfachten Modellen auf?  

4. Wenn sich das Problem nicht lösen lässt, notieren Sie bitte Folgendes:  
• Software-Produkt  

(PTC Creo Parametric, PTC Creo Elements/Direct Modeling, PTC Creo Elements/Direct 
Drafting, PTC Creo Elements/Direct Model Manager ...)  

• Version der Software (siehe Tabelle unten)  

• Welche Hardware, welches Betriebssystem (und Version) wird verwendet?  

• Wie viel Arbeitsspeicher steht zur Verfügung?  

• Mitteilungen, Fehlermeldungen. Erstellen Sie ggf. einen Bildschirmabzug 

2.1.1 Wie stelle ich fest, welche Softwareversion installiert ist? 

 

PTC Creo Wählen Sie Datei » Hilfe » Über Creo …  
(File » Help » About …) 

PTC Creo Elements/Pro und 
ältere Pro/ENGINEER Versionen 

Wählen Sie Hilfe » Über … 
(Help » About) 

PTC Windchill PDMLink 
 

Klicken Sie auf Schnell-Links » Hilfe » Infos zu 
Windchill PDMLink 

PTC Creo Elements/Direct 
Produkte 

Klicken Sie auf Hilfe » Über Creo Elements/Direct … 
(Help » About …) 
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2.2 Checkliste NetApp Support 

1. System-Seriennummer/-Name 

2. Welches Problem tritt auf? 

3. Wurde eine Autosupport-Mail ausgelöst? 

4. Wie kann mich der INNEO-Service erreichen? (Telefon, E-Mail, Zeiten der Verfügbarkeit) 
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3 Tickets eröffnen und deren Status verfolgen 

3.1 Tickets per Telefon eröffnen 

Sie erreichen den Technischen Support unter der gebührenfreien Rufnummer 00800 4200 4300 Montag bis 
Freitag von 8:00 Uhr bis 18:00 Uhr. Außerhalb dieser Zeiten steht Ihnen eine englischsprachige 
Supporthotline von PTC zu Verfügung (siehe 3.1.2 – Außerhalb der Geschäftszeiten (PTC Support)). 

Wir setzen ein ACD-System (Automated Call Distribution) ein, um Sie schnellstmöglich mit dem richtigen 
Ansprechpartner zu verbinden. ACD-Systeme setzen das Tonwahlverfahren voraus, sollten Sie feststellen, 
dass das System Ihre Eingaben nicht erkennt, kontaktieren Sie bitte den Ansprechpartner für Ihre 
Telefonanlage oder warten Sie die komplette Ansage ab. Anschließend werden Sie automatisch mit einem 
Mitarbeiter verbunden, der Ihr Anliegen bearbeitet. 

3.1.1 Innerhalb unserer Geschäftszeiten 

Nach Anwahl der gebührenfreien Telefonnummer werden Sie vom System begrüßt: 

1. Wählen Sie im ersten Schritt Ihre Sprache (1 für Deutsch, 2 für Englisch)  

2. Wählen Sie eine der sieben Hauptkategorien, indem Sie die entsprechende Taste drücken 
(beispielsweise die 2 für PTC-Produkte). 
 Entsprechend Ihrer Auswahl werden Ihnen weitere Menüpunkte angeboten, wie z.B. 
Installation, Bauteile und Baugruppen etc. Bestätigen Sie diese Auswahl entsprechend Ihrer 
Problemstellung 

3. Nach der Auswahl wird Ihr Anruf direkt an einen der zuständigen Ingenieure weitergeleitet. 

Wir sind bestrebt, jedes Gespräch direkt entgegenzunehmen. Sollte zeitweise kein Mitarbeiter zur Verfügung 
stehen, haben Sie nach 3 Minuten die Möglichkeit, eine Nachricht zu hinterlassen. Hinterlassen Sie in jedem 
Fall Ihren Namen, den Firmennamen und die Telefonnummer, unter der wir Sie erreichen können. Wir 
versuchen, Sie umgehend zurückzurufen. 

Hinweis: 
Sie erhalten für jede Ihrer Anfragen eine Ticketnummer, die bei späteren Anrufen und auch im 
Online-Ticketsystem als Referenz verwendet werden kann. 

Hinweis: 
Sie müssen die Ansagen nicht bis zum Ende anhören. Sobald Sie die Stimme hören, können 
Sie die nächste Menüauswahl treffen. Auf diese Weise lässt sich die Zeit bis zur 
Entgegennahme des Gesprächs verkürzen. Als Referenz können Sie das Einwahlschema auf 
Seite 22 zu Hilfe nehmen. 
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3.1.2 Außerhalb der Geschäftszeiten (PTC Support) 

Außerhalb unserer Geschäftszeiten (nur in englischer Sprache): 

Nach Anwahl der internationalen Rufnummer werden Sie kurz nach der Telefonansage an unser 
englischsprachiges Nachtteam weitergeleitet. 
Um Zugang zu diesem Service zu erhalten, werden Sie gebeten, Ihre SCN-Nummer einzugeben. 
Die SCN-Nummer (Service Contract Number) finden Sie bei den Versionsinformationen (siehe 2.1 
Checkliste), z. B. 

Version:  Creo 6.0 
Datumscode:  M020 
Servicevertrag-Nummer: 5A123456 
 

oder in Ihrer Lizenzdatei: 

#********************** Summary Table ****************************************** 
#               PTC Host ID 00-1A-60-12-34-5D 
#FeatureName      Qty   Product     Release   Type      Expiration     Contract 
#******************************************************************************* 
#PROE_FoundAdv  1   Pro/E Found.Adv  Creo 6.0    Flt Lic    perm          
5A123456 
 

3.1.3 Außerhalb der Geschäftszeiten (NetApp Support) 

Der NetApp Support ist rund um die Uhr erreichbar (24/7). Siehe hierzu Einwahlschema des Telefonsystems 
im Anhang. 
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3.2 Tickets via E-Mail eröffnen 

Senden Sie Ihre E-Mail an support@inneo.com 

3.3 Tickets über das Internet eröffnen 

Wir nutzen ein Online-Ticketsystem, um Ihre Anfragen entgegen zu nehmen und Sie jederzeit über den 
Status Ihres Anliegens informieren zu können.  

Um zum Ticketsystem zu gelangen, navigieren Sie zur INNEO Website und klicken Sie am rechten 
Bildschirmrand auf „Support“ und anschließend auf „Online Ticketsystem“. Alternativ können Sie 
folgende URL direkt aufrufen: https://support.inneo.com. 
 Sie werden zum Login weitergeleitet. 

Hinweis: 
Alle Online-Tools von INNEO nutzen einen zentralen Login. Wenn Sie bereits ein Kundenkonto 
besitzen, so können Sie sich mit diesen Informationen direkt am Ticketsystem anmelden. Im 
Punkt 3.3.2 - Wenn Sie noch kein Kundenkonto besitzen erfahren Sie, wie Sie ein neues 
Kundenkonto anlegen. 

3.3.1 Wenn Sie bereits ein Kundenkonto besitzen 

 
Tragen Sie Ihre E-Mail-Adresse ein und klicken Sie auf „Weiter“.  

mailto:support@inneo.com
https://support.inneo.com/
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Geben Sie Ihr Kennwort ein und klicken Sie auf „Anmelden“ 
 Sie werden ins Ticketsystem weitergeleitet 

 
Um ein neues Ticket zu eröffnen, wählen Sie den passenden Bereich und klicken Sie dort auf „Ticket 
eröffnen“. 
 Sie können nun ein neues Ticket anlegen 
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Füllen Sie das Formular möglichst vollständig aus.  

Geben Sie Details zu Ihrem Problem im Feld „Beschreibung“ an. Hier haben Sie zusätzlich die Möglichkeit, 
Ihre Texte zu formatieren und Bilder einzufügen. Die entsprechenden Werkzeuge finden Sie in den Reitern 
„Text formatieren“ und „Einfügen“ in der Werkzeugleiste am oberen Bildschirmrand. 

Hinweis: 
Detaillierte Angaben helfen, Rückfragen zu verringern und ermöglichen es uns, Ihr Ticket 
schneller zu bearbeiten. 

Am Ende des Formulars können Sie Dateien wie beispielsweise Logfiles, kleinere Modelle oder Screenshots 
mit einer Dateigröße von maximal 20 MB hochladen. Ziehen Sie diese hierfür einfach in den grauen Bereich 
mit der Aufschrift „Ablagebereich für Dateien“. 

Um Ihr Ticket abzuschicken, klicken Sie auf „Speichern“. 
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3.3.2 Wenn Sie noch kein Kundenkonto besitzen 

 
Klicken Sie auf „Jetzt registrieren“ 
 Sie werden in den Dialog zur Erstellung eines neuen Kundenkontos weitergeleitet 

 
Füllen Sie das Formular aus und klicken Sie auf „Konto anlegen“. Mit * gekennzeichnete Felder sind 
Pflichtfelder. 
 Sie werden ins Ticketsystem weitergeleitet. (Fahren Sie fort wie unter 3.3.1- Wenn Sie bereits ein 
Kundenkonto besitzen beschrieben) 

Hinweis: 
Für den Fall, dass wir Ihre Eingaben nicht eindeutig einer Firma zuordnen können, werden Sie 
erneut aufgefordert, Ihren Firmennamen einzugeben: 
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Nachdem wir Ihre Eingaben überprüft haben, erhalten Sie eine Bestätigung per E-Mail. 

3.4 Den Status eines Tickets online verfolgen 

Ihre bestehenden Tickets finden Sie auf der Startseite des Ticketsystems im Bereich „Alle offenen 
Tickets“. 

 
In der Liste erhalten Sie alle grundlegenden Daten zu Ihren Tickets sowie Informationen zum 
Bearbeitungsstatus. 

Klicken Sie den Betreff eines Tickets an, um weitere Informationen zu erhalten. 
 Sie werden auf die Detailseite weitergeleitet. 
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Im oberen Bereich finden Sie Informationen zum Ticket wie Beschreibung, Status und Bearbeiter. 

Im Bereich „Notizen“ finden Sie nach Bearbeitung Ihres Tickets Hinweise zur Problemlösung. 

 
Im Bereich „Kommunikation“ finden Sie Ihre gesamte Kommunikationshistorie mit INNEO zum jeweiligen 
Ticket. Dies beinhaltet auch E-Mails, Telefonate und TeamViewer-Sitzungen.  

Klicken Sie den Betreff eines Eintrags an, um diesen zu öffnen. 

Um auf eine Nachricht von INNEO zu antworten oder eine neue Nachricht zu erstellen, klicken Sie in der 
Werkzeugleiste auf „Antwort“ oder nutzen Sie die Schaltfläche „Neuen Kommunikationseintrag 
erstellen“. 

Im Bereich „Anlagen“ können Sie alle zu Ihrem Ticket hochgeladenen Dateien einsehen. 

Im Bereich „Zeiteinträge“ werden ggf. anfallende Zeiten für die Bearbeitung Ihres Tickets hinterlegt. 
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4 Lizenzmanagement 

Viele Programme benötigen bei einem Versionsupdate, beim Wechsel auf neue Hardware oder bei einem 
Wechsel an einen anderen Standort eine aktualisierte Lizenzdatei. Sie können diese bequem über unser 
Online Ticketsystem anfordern. 

4.1 Lizenzanforderung bei Update oder Ortswechsel 

Den Zugang zum Lizenzformular finden Sie auf der Startseite des Online Ticketsystems. Wenn Sie noch 
keinen Zugang zum Online Ticket System haben, erfahren Sie in Kapitel 3.3.2 - Wenn Sie noch kein 
Kundenkonto besitzen, wie Sie diesen einrichten. 

 
Klicken Sie zum Beginn auf den Button „Lizenz-Anforderung“. 

Wählen Sie im nun folgenden Dialog Ihr Lizenzszenario entsprechend Ihren Produkten und Ihrem Lizenzfall 
aus und klicken Sie die entsprechende Schaltfläche. 
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4.1.1 Umlizenzierung für PTC-, INNEO- und B&W-Produkte 

Klicken Sie auf den Button „Lizenz umziehen“, um bestehende Lizenzen auf einem Computer mit neuer 
MAC-Adresse zu nutzen. 

 
Bestätigen Sie zuerst, dass Sie befugt sind, den Lizenzumzug zu autorisieren, indem Sie den 
entsprechenden Haken setzen. Tragen Sie anschließend die aktuelle und neue MAC-Adresse ein.  

Hinweis: 
Klicken Sie auf „Anleitung MAC-Adresse“, um zu erfahren, wie Sie Ihre MAC-Adresse 
auslesen. 

Füllen Sie anschließend das Formular vollständig aus und bestätigen Sie den Deinstallationsvertrag. 

Am Ende des Formulars können Sie Ihre bisherige Lizenzdatei als Referenz hochladen. Dies ist optional, 
kann jedoch die Bearbeitung Ihrer Anfrage beschleunigen. Klicken Sie hierfür auf „Durchsuchen“ und 
wählen Sie die Datei aus. Klicken Sie anschließend auf „Hochladen“. 

Klicken Sie zum Abschluss auf „Absenden“, um den Umzug Ihrer Lizenzen zu beauftragen. 
 Sie erhalten eine Bestätigung Ihrer Anfrage und es wird ein Ticket im Online Ticket System für Sie 
angelegt. 

 
Sie können den Status Ihrer Lizenzanfrage jederzeit im Bereich „Alle offenen Tickets“ einsehen. 
Rückfragen werden ebenso über dieses Ticket abgewickelt wie die Bereitstellung Ihrer Lizenzdatei nach 
Abschluss Ihrer Anfrage. 
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4.1.2 Lizenzupdate für PTC-, INNEO- und B&W-Produkte 

Klicken Sie auf den Button „Lizenz für neue Version abrufen“, um eine Lizenzdatei für eine neue 
Produktversion anzufordern. 

 
Bestätigen Sie zuerst, dass Sie befugt sind, den Lizenzumzug zu autorisieren, indem Sie den 
entsprechenden Haken setzen. Tragen Sie anschließend die neue MAC-Adresse ein.  

Hinweis: 
Klicken Sie auf „Anleitung MAC-Adresse“, um zu erfahren, wie Sie Ihre MAC-Adresse 
auslesen. 

Füllen Sie anschließend das Formular vollständig aus. 

Am Ende des Formulars können Sie Ihre bisherige Lizenzdatei als Referenz hochladen. Dies ist optional, 
kann jedoch die Bearbeitung Ihrer Anfrage beschleunigen. Klicken Sie hierfür auf „Durchsuchen“ und 
wählen Sie die Datei aus. Klicken Sie anschließend auf „Hochladen“. 

Klicken Sie zum Abschluss auf „Absenden“, um Ihre neue Lizenzdatei anzufordern. 
 Sie erhalten eine Bestätigung Ihrer Anfrage und es wird ein Ticket im Online Ticket System für Sie 
angelegt. 

 
Sie können den Status Ihrer Lizenzanfrage jederzeit im Bereich „Alle offenen Tickets“ einsehen. 
Rückfragen werden ebenso über dieses Ticket abgewickelt wie die Bereitstellung Ihrer Lizenzdatei nach 
Abschluss Ihrer Anfrage. 
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4.1.3 Lizenzupdate für KeyShot 

Klicken Sie auf den Button „Lizenz für Update (KeyShot Floating)“, um eine Lizenzdatei für eine neue 
KeyShot Version anzufordern. 

 
Bestätigen Sie zuerst, dass Sie befugt sind, den Lizenzumzug zu autorisieren, indem Sie den 
entsprechenden Haken setzen. Tragen Sie anschließend die neue MAC-Adresse ein.  

Hinweis: 
Klicken Sie auf „Anleitung MAC-Adresse“, um zu erfahren, wie Sie Ihre MAC-Adresse 
auslesen. 

Füllen Sie das Formular vollständig aus.  

Am Ende des Formulars können Sie Ihre bisherige Lizenzdatei als Referenz hochladen. Dies ist optional, 
kann jedoch die Bearbeitung Ihrer Anfrage beschleunigen. Klicken Sie hierfür auf „Durchsuchen“ und 
wählen Sie die Datei aus. Klicken Sie anschließend auf „Hochladen“. 

Klicken Sie zum Abschluss auf „Absenden“, um Ihre neue Lizenzdatei anzufordern. 
 Sie erhalten eine Bestätigung Ihrer Anfrage und es wird ein Ticket im Online Ticket System für Sie 
angelegt. 

 
Sie können den Status Ihrer Lizenzanfrage jederzeit im Bereich „Alle offenen Tickets“ einsehen. 
Rückfragen werden ebenso über dieses Ticket abgewickelt wie die Bereitstellung Ihrer Lizenzdatei nach 
Abschluss Ihrer Anfrage. 
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4.1.4 Umlizenzierung für KeyShot 

Klicken Sie auf den Button „KeyShot Lizenz umlizenzieren“, um bestehende KeyShot-Lizenzen auf einem 
Computer mit neuer MAC-Adresse zu nutzen. 

 
Klicken Sie auf „Formular des Herstellers“ und laden Sie dort das Formular herunter. Füllen Sie das 
Formular vollständig aus. Und bestätigen Sie die Uminstallation mit Ihrer Unterschrift 

Laden Sie anschließend das ausgefüllte und unterschriebene Formular wieder hoch. Klicken Sie hierfür auf 
„Durchsuchen“ und wählen Sie die Datei aus. Klicken Sie anschließend auf „Hochladen“. 

Klicken Sie zum Abschluss auf „Absenden“, um den Umzug Ihrer Lizenzen zu beauftragen. 
 Sie erhalten eine Bestätigung Ihrer Anfrage und es wird ein Ticket im Online Ticket System für Sie 
angelegt. 

 
Sie können den Status Ihrer Lizenzanfrage jederzeit im Bereich „Alle offenen Tickets“ einsehen. 
Rückfragen werden ebenso über dieses Ticket abgewickelt wie die Bereitstellung Ihrer Lizenzdatei nach 
Abschluss Ihrer Anfrage. 
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4.2 Firmenübergreifender Lizenztransfer und Änderung der 
Firmendaten 

Für den Fall, dass sich Ihr Firmenname oder Ihre Anschrift geändert hat oder Sie Lizenzen auf ein anderes 
Unternehmen übertragen möchten stehen auf unserer Internetseite passende Formulare zum Download 
bereit. 

Navigieren Sie zur INNEO Website und klicken Sie am rechten Bildschirmrand auf „Support“ und 
anschließend auf „Lizenzabteilung“. Scrollen Sie auf der Folgeseite nach Unten, bis Sie rechts die Spalte 
„Formulare und Services“ sehen. 

 
Klicken Sie auf „Namensänderung / Adressänderung mitteilen“ oder auf „Transfer von PTC-Lizenzen 
auf neue Firma (DE, CH, UK)“, um die entsprechenden Formulare herunterzuladen. 

Füllen Sie die Formulare vollständig aus und speichern diese. Hängen Sie das ausgefüllte Formular und ggf. 
nötige Unterlagen an eine E-Mail und senden Sie diese an ilc@inneo.com.  

mailto:ilc@inneo.com
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5 Anhang  

5.1 Dateien an den Technischen Support senden 

Im Rahmen Ihrer Anfrage haben Sie verschiedene Möglichkeiten, Dateien an den Technischen Support zu 
senden. Zu jeder Anfrage erzeugen wir eine Ticketnummer, die Sie dann als Referenz bei der Übermittlung 
verwenden können. 

Packen Sie die zur Bearbeitung des Falles erforderliche(n) Datei(en) im Format .zip, .rar oder gzip. 

● Übermittlung per Mail: 
Nennen Sie die Ticketnummer im Betreff und hängen Sie die komprimierte Datei mit „Einfügen“ – 
„Datei anfügen“ an Ihre E-Mail an. Senden Sie Ihre Nachricht an support@inneo.com 

● Übermittlung im Online-Ticketsystem: 
Dateien < 20 MB können Sie direkt bei der Ticketerstellung hochladen oder nachträglich im Bereich 
„Kommunikation“ an ein bestehendes Ticket anhängen. 

● Für Datenmengen >20 MB nehmen Sie bitte Kontakt mit den Mitarbeitern des Technischen Supports 
auf. Sie werden Ihnen einen geeigneten Link zum Upload der Daten zur Verfügung stellen. 

  

mailto:support@inneo.com
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5.2 Feststellen der MAC-Adresse eines Rechners 

Öffnen Sie die Windows Eingabeaufforderung 

Hinweis: 
Sie finden die Eingabeaufforderung, im Startmenü im Order „Windows-System“ oder indem 
Sie nach „cmd“ suchen. 

Nutzen Sie alternativ die Tastenkombination „+R“ 
 Das Fenster „Ausführen“ erscheint 

 

Tippen Sie „cmd“ in das Eingabefeld und bestätigen Sie die Eingabe mit der Eingabetaste 
oder klicken Sie auf „OK“ 

 
Geben Sie in der Eingabeaufforderung den Befehl ipconfig /all ein und bestätigen Sie mit der Eingabetaste 
 Sie erhalten eine Auflistung der Netzwerkeinstellungen und Adapter. 

Die Gesuchte MAC-Adresse finden Sie unter dem Eintrag Physische Adresse. Notieren Sie diese zur 
späteren Nutzung im Lizenzformular. 
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5.3 Schema des ACD-Systems des Technischen Support 

Mit Hilfe der Abbildung können Sie bereits vor Ihrem Anruf die gewünschte Tastenfolge ermitteln, um die 
Entgegennahme zu beschleunigen. 
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